


ELECTRONIC ARTS SOFTWARE END USER LICENSE 
AGREEMENT FOR THE EA DOWNLOAD MANAGER
This End User License Agreement (“License”) is an agreement between you and Electronic Arts Inc. (“EA”). This License governs your use of 
this application and all related software, documentation, and updates and upgrades that replace or supplement the application and are not 
distributed with a separate license (together, the “Application”).
By installing or using The APPLICATION, you consent to be bound by this LICENSE. If you do not agree to all of the terms of this LICENSE, then 
do not install or use the APPLICATION. IF YOU INSTALL the Application, the terms and CONDITIONS of this LICENSE ARE fully accepted by you. 

1.	 License Grant and Terms of Use. 
A.	 Grant. EA grants you a personal, non-exclusive license to install and use the Application for your personal, noncommercial use 

solely as set forth in this License and any accompanying documentation. Any commercial use is prohibited. You are expressly 
prohibited from sublicensing, renting, leasing or otherwise distributing the Application or rights to use the Application. The term of 
your license shall commence on the date that you start to download, install or otherwise use the Application, and shall end on the 
earlier of the date that you dispose of the Application; or EA’s termination of this License. 

B.	 Copies. You may download the number of copies allowed by the Application’s digital rights management from an authorized 
source. The number of copies that you can download during a consecutive period of days may be limited. You may use only 
one copy of the Application at any given time. You may not make a copy of the Application available on a network where it 
could be used by multiple users at the same time. You may not make the Application available over a network where it could be 
downloaded by multiple users. For more information concerning the digital rights management that applies to the Application, 
please review the terms accompanying the distribution of the Application. Your license will terminate immediately if you attempt 
to circumvent digital rights management or other terms and conditions that apply to the Application or the software delivered 
through the Application.

C.	 License Validation. The Application is required to validate the license for certain products distributed by EA. You acknowledge 
and agree that the Application will automatically validate license rights for some or all EA products without separate notice to 
you. This means that in order to use the Application and certain EA products, you must leave the Application installed on your 
computer and maintain a connection to the Internet. You acknowledge and agree that the Application may use information 
regarding your computer and your use of the Application to validate your license rights and to update the Application. We may 
use this information to improve our products and services and may disclose this information to others for that purpose, but not in 
a form that personally identifies you. You also agree that the Application may automatically download and install updates that EA 
deems necessary. You acknowledge that any obligation EA may have to support the previous version(s) may be ended upon the 
availability of the update.

D.	 Reservation of Rights and Restrictions. The Application is licensed, and not sold, to you for use only under the terms of this 
License. Except as expressly licensed to you herein, EA reserves all right, title and interest in the Application and all software 
delivered through the Application (including all characters, storyline, images, photographs, animations, video, music, text), and all 
associated copyrights, trademarks, and other intellectual property rights therein. The License is limited to the intellectual property 
rights of EA and its licensors in the Application and does not include any rights to other patents or intellectual property. Except, 
and only to the extent that may be permitted under applicable law, you may not decompile, disassemble, or reverse engineer 
the Application by any means whatsoever, or alter, modify, enhance, or create a derivative work of the Application. You may not 
remove, alter, or obscure any product identification, copyright, or other intellectual property notices in the Application or software 
delivered through the Application. 

2. 	 Consent to Use of Data. You agree that EA may collect, use, store and transmit technical and related information that identifies 
your computer (including the Internet Protocol Address), operating system and application software and peripheral hardware, that 
may be gathered periodically to facilitate the provision of software updates, dynamically served content, product support and other 
services to you, including online play. EA may also use this information in the aggregate and, in a form which does not personally 
identify you, to improve our products and services and we may share that data with our third party service providers. IF YOU 
DO NOT WANT EA TO COLLECT, USE, STORE, TRANSMIT OR DISPLAY THE DATA DESCRIBED IN THIS SECTION, PLEASE DO NOT 
INSTALL OR USE THE APPLICATION.

3. 	 Consent to Public Display of Data. When you use the Application online, EA and its affiliates may also collect, use, store, transmit 
and publicly display statistical data regarding game play when you use the Application online (including scores, rankings and 
achievements), or to identify content that is created and shared by you with other players. Data that personally identified you is 
collected, used, stored and transmitted in accordance with EA’s Privacy Policy located at privacy.ea.com.

4. 	 Termination. This License is effective until terminated. Your rights under this License will terminate immediately and automatically 
without any notice from EA if (i) you fail to comply with any of the terms and conditions of this License; or (ii) EA ceases to support 
the Application. Promptly upon termination, you must cease all use of the Application and destroy all copies of the Application in 
your possession or control. EA’s termination will not limit any of EA’s other rights or remedies at law or in equity. Sections 2-10 of 
this License shall survive termination or expiration of this License for any reason. 

5. 	 Disclaimer of Warranties. TO THE FULLEST EXTENT PERMISSIBLE UNDER APPLICABLE LAW, THE APPLICATION IS PROVIDED TO 
YOU “AS IS,” WITH ALL FAULTS, WITHOUT WARRANTY OF ANY KIND, AND YOUR USE IS AT YOUR SOLE RISK. THE ENTIRE RISK OF 
SATISFACTORY QUALITY AND PERFORMANCE RESIDES WITH YOU. EA AND EA’S LICENSORS (COLLECTIVELY EA FOR PURPOSES 
OF THIS SECTION AND SECTION 6) DO NOT MAKE, AND HEREBY DISCLAIM, ANY AND ALL EXPRESS, IMPLIED OR STATUTORY 
WARRANTIES, INCLUDING IMPLIED WARRANTIES OF MERCHANTABILITY, SATISFACTORY QUALITY, FITNESS FOR A PARTICULAR 
PURPOSE, NONINFRINGEMENT OF THIRD PARTY RIGHTS, AND WARRANTIES (IF ANY) ARISING FROM A COURSE OF DEALING, 
USAGE, OR TRADE PRACTICE. EA DOES NOT WARRANT AGAINST INTERFERENCE WITH YOUR ENJOYMENT OF THE APPLICATION; 
THAT THE APPLICATION WILL MEET YOUR REQUIREMENTS; THAT OPERATION OF THE APPLICATION WILL BE UNINTERRUPTED OR 
ERROR-FREE, OR THAT THE APPLICATION WILL BE COMPATIBLE WITH THIRD PARTY SOFTWARE OR THAT ANY ERRORS IN THE 
APPLICATION WILL BE CORRECTED. NO ORAL OR WRITTEN ADVICE PROVIDED BY EA OR ANY AUTHORIZED REPRESENTATIVE SHALL 
CREATE A WARRANTY. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF OR LIMITATIONS ON IMPLIED WARRANTIES OR 
THE LIMITATIONS ON THE APPLICABLE STATUTORY RIGHTS OF A CONSUMER, SO SOME OR ALL OF THE ABOVE EXCLUSIONS AND 
LIMITATIONS MAY NOT APPLY TO YOU.

6. 	 Limitation of Liability. TO THE FULLEST EXTENT PERMISSIBLE BY APPLICABLE LAW, IN NO EVENT SHALL EA BE LIABLE TO YOU 
FOR ANY PERSONAL INJURY, PROPERTY DAMAGE, LOST PROFITS, COST OF SUBSTITUTE GOODS OR SERVICES, OR ANY FORM 
OF INDIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL OR PUNITIVE DAMAGES FROM ANY CAUSES OF ACTION RELATED TO THIS 
LICENSE OR THE APPLICATION, WHETHER ARISING IN TORT (INCLUDING NEGLIGENCE), CONTRACT, STRICT LIABILITY OR OTHERWISE, 
WHETHER OR NOT EA HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. SOME JURISDICTIONS DO NOT ALLOW THE 
LIMITATION OF LIABILITY FOR DEATH, PERSONAL INJURY, FRAUDULENT MISREPRESENTATIONS OR CERTAIN INTENTIONAL OR 
NEGLIGENT ACTS, OR VIOLATION OF SPECIFIC STATUTES, OR THE LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO 
SOME OR ALL OF THE ABOVE LIMITATIONS OF LIABILITY MAY NOT APPLY TO YOU. In no event shall EA’s total liability to you for all 
damages (except as may be required under applicable law) exceed the amount actually paid by you for the Application. 

7. 	 Limitation of Liability is a Material Term of this License. You agree that the provisions in this License that limit liability are 
essential terms of this License. The foregoing limitations of liability apply even if any remedies described in this License fail in their 
essential purpose. 

8. 	 Severability and Survival. If any provision of this License is illegal or unenforceable under applicable law, the remainder of the 
provision shall be amended to achieve as closely as possible the effect of the original term and all other provisions shall continue in 
full force and effect. 

9. 	 U.S. Government Restricted Rights. If you are a government end user, then this provision applies to you. The software provided in 
connection with this License has been developed entirely at private expense, as defined in FAR section 2.101, DFARS section 252.227-
7014(a)(1) and DFARS section 252.227-7015 (or any equivalent or subsequent agency regulation thereof), “commercial items,” 
“commercial computer software” and/or “commercial computer software documentation.” Consistent with DFARS section 227.7202 
and FAR section 12.212, and to the extent required under U.S. federal law, the minimum restricted rights as set forth in FAR section 
52.227-19 (or any equivalent or subsequent agency regulation thereof), any use, modification, reproduction, release, performance, 
display, disclosure or distribution thereof by or for the U.S. Government shall be governed solely by this License and shall be prohibited 
except to the extent expressly permitted by this License.

10. 	 Injunctive Relief. You agree that a breach of this License may cause irreparable injury to EA for which monetary damages would not 
be an adequate remedy and EA shall be entitled to seek equitable relief in addition to any remedies it may have hereunder or at law.

11. 	 Governing Law. This License shall be governed by and construed (without regard to conflicts or choice of law principles) under the 
laws of the State of California as applied to agreements entered into and to be performed entirely in California between California 
residents. Unless expressly waived by EA in writing for the particular instance or contrary to local law, the sole and exclusive 
jurisdiction and venue for actions related to the subject matter hereof shall be the California state and federal courts having within 
their jurisdiction the location of EA’s principal place of business. Both parties consent to the jurisdiction of such courts and agree 
that process may be served in the manner provided herein for giving of notices or otherwise as allowed by California or federal 
law. The parties agree that the UN Convention on Contracts for the International Sale of Goods (Vienna, 1980) shall not apply to this 
License or to any dispute or transaction arising out of this License.

12. 	 Export. You agree to abide by U.S. and other applicable export control laws and agree not to transfer the Application to a foreign 
national, or national destination, which is prohibited by such laws, without first obtaining, and then complying with, any requisite 
government authorization. You certify that you are not a person with whom EA is prohibited from transacting business under 
applicable law.

13. 	 Third Party Notices. Adobe® Flash® Player. Copyright © 1996 – 2006 Adobe Systems Incorporated. All Rights Reserved. 
Protected by U.S. Patent 6,879,327; Patents Pending in the United States and other countries. Adobe and Flash are either 
trademarks or registered trademarks in the United States and/or other countries.

14. 	 Entire Agreement. This License constitutes the entire agreement between you and EA with respect to the Application and 
supersedes all prior or contemporaneous understandings regarding such subject matter. No amendment to or modification of this 
License will be binding unless made in writing and signed by EA. No failure to exercise, and no delay in exercising, on the part of 
either party, any right or any power hereunder shall operate as a waiver thereof, nor shall any single or partial exercise of any right 
or power hereunder preclude further exercise of any other right hereunder. In the event of a conflict between this License and any 
applicable purchase or other terms, the terms of this License shall govern.

http://privacy.ea.com
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This product has been rated by the Entertainment Software Rating Board. For information about the ESRB 
rating please visit www.esrb.org.
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Installing the Game
Note: For system requirements, see the readme file.

To install on a PC (disc users):
Insert the disc into your disc drive and follow the on-screen instructions.
Once the game has installed you can launch it from the game’s AutoRun menu or by locating the game 
through the START menu. 
Games on Windows Vista™ are located in the Start > Games menu and on earlier versions of Windows™ in 
the Start > Programs (or All Programs) menu.

To install on a PC (EA Store users):
Note: If you’d like more information about purchasing direct downloads from EA, visit  
www.eastore.ea.com and click MORE ABOUT DIRECT DOWNLOADS.
Once the game has been downloaded by EA Download Manager, click the install icon that appears and 
follow the on-screen instructions.
Launch the game (once it is installed) directly from the EA Download Manager.
Note: If you’ve already purchased a title and would like to install it on another PC, first download and install 
the EA Download Manager on the other PC, then launch the application and log in with your EA account. Select 
the appropriate title from the list that appears and click the start button to download the game.

To install on a Macintosh:
1.	 Insert the game disc into your DVD-ROM drive. A DVD icon representing the game disc appears on your 

desktop. Double-click the icon to open the game’s launcher.
2.	 Select the game’s installer icon at the bottom of the launcher to prompt the installation menu. 
3.	 Follow the on-screen instructions to complete the installation.

To install on a PC or Macintosh (third party online users):
Please contact the digital retailer through whom you purchased this game for instructions on how to install 
the game or how to download and reinstall another copy.

Starting the Game
To start the game:
For PC:
Games on Windows Vista™ are located in the Start > Games menu and on earlier versions of Windows™ in 
the Start > Programs (or All Programs) menu.
For Macintosh:
Open a Finder window, select ‘Applications,’ and double-click the game’s icon.
INTERNET CONNECTION, ONLINE AUTHENTICATION AND ACCEPTANCE OF END USER LICENSE AGREEMENT REQUIRED TO PLAY THE SIMS 3 DIGITAL DOWNLOAD 
PRODUCT. ACCESS TO ONLINE SERVICES INCLUDING SIMPOINTS AND DOWNLOADS REQUIRES AN INTERNET CONNECTION, EA ACCOUNT AND GAME 
REGISTRATION WITH THE PROVIDED SERIAL CODE. REGISTRATION IS LIMITED TO ONE EA ACCOUNT PER SERIAL CODE AND IS NON-TRANSFERABLE. EA ONLINE 
TERMS & CONDITIONS CAN BE FOUND AT WWW.EA.COM. YOU MUST BE 13+ TO REGISTER FOR AN EA ACCOUNT. MAC USERS MUST UPDATE TO THE LATEST 
VERSION OF THE SIMS 3 LAUNCHER TO ACCESS ONLINE SERVICES, INCLUDING FREE SIMPOINTS AND DOWNLOADS. EA MAY PROVIDE CERTAIN INCREMENTAL 
CONTENT AND/OR UPDATES FOR NO ADDITIONAL CHARGE, IF AND WHEN AVAILABLE. The Sims 3 digital download PRODUCT uses SecuROM digital 
rights management technology provided by Sony DADC Austria AG. For more information about SecuROM, visit http://faq.securom.com/.
EA MAY RETIRE ONLINE FEATURES AFTER 30 DAYS NOTICE POSTED ON WWW.EA.COM.

www.thesims3.com

http://www.esrb.org
http://www.eastore.ea.com
http://www.ea.com
http://faq.securom.com/
http://www.ea.com
http://www.thesims3.com
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Time Controls
Pause game P, 0, or ` 
Regular/fast/ultra speed 1/2/3 (or corresponding keys on Num Pad)
Fast forward to end of interaction 4

House Controls
WINDOWS MacBook

Next/previous floor PG UP/PG DOWN Fn + Up Arrow/ Down Arrow
Next/previous wall mode HOME/END Fn + Left Arrow/ Right Arrow
Center on selected Sim’s lot SHIFT-ENTER

Camera Movements
Move left/right left arrow/right arrow or A/D
Move forward/back up arrow up/down arrow or W/S
Move faster SHIFT + arrows or SHIFT + A/S/W/D
Zoom in/out Z/X or =/- or Num Pad +/ Num Pad -
Rotate left/right , (comma)/. (period)
Save camera position 1 - 5 CTRL-5 - 9
Snap camera position 1 - 5 SHIFT-5 - 9
Move to camera position 1 - 5 5 - 9
Toggle cameraman mode TAB
Toggle map mode M

Gameplay Modes
Live Mode F1
Buy Mode F2
Build Mode F3
Options Mode F5

 Mac OS X Shortcuts
Toggle between windowed and 
full-screen view

Command-Return 

Minimize the game when in full-screen 
mode

Command-Tab

 Right and Middle Mouse Button Functionality on Mac OS X 
Some features in The Sims 3 require a right mouse button and a middle mouse button. If you have an 
Apple Mighty Mouse, you can enable the right mouse button in System Preferences > Keyboard and 
Mouse. Change the RIGHT CLICK drop down to SECONDARY BUTTON.
Most PC USB mice are supported on the Macintosh as well. The left, right, and middle mouse buttons 
are detected and work correctly when first plugged in.
If you have an Apple legacy single button mouse, or a MacBook with a Track Pad, you can emulate a 
right mouse button click by holding down the Command key while clicking the mouse button. 
To emulate the middle mouse button using a single button mouse, hold down the Control and 
Command keys while clicking the mouse button.

Key Commands
General Controls

Undo/Redo CTRL-Z/CTRL-Y
Cancel ESC
Toggle cheat entry window CTRL-SHIFT-C
Hide/show UI F10

Create A Sim
Rotate Sim , (comma)/. (period)
Zoom in/out mouse wheel

Build/Buy Mode
Object Placement Tools

Rotate object , (comma)/. (period)
Delete object DEL or BACKSPACE
Enable free-form placement ALT (while holding or moving an object)
Enable free-form rotation ALT (while rotating an object with the 

mouse)
Move object to next slot in surface M

Build Room Controls
Create room wall tool + SHIFT + drag
Fill room with wallpaper/flooring SHIFT + click (when using the wallpaper/

flooring tool)
Rotate floor tile floor tool: , (comma)/. (period)
Toggle full/quarter tile mode CTRL-F

Movie Making Mode
Enable movie making mode TAB
Start/end video capture V
Lower/raise camera height Q/E
Roll camera counterclockwise/ clockwise SHIFT-A/SHIFT-D
Level out the camera roll SHIFT-S
Adjust focal length Z/X
Take a snapshot C

Live Mode
Sim/Household Controls

Switch to next Sim in household SPACE
Switch to (specific) Sim Click Sim portrait
Lock camera to Sim Right-click Sim portrait
Center on active Sim ENTER
Access skill journal J
Access inventory I
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Get Inspired!
The Sims™ 3 will inspire you with its endless creative possibilities and amuse you with unexpected 
moments of surprise and mischief! Create amazingly unique Sims by customizing their appearances 
and choosing specific personality traits. Then build their houses—design everything from an exquisitely 
furnished dream home to a rundown seaside shack. Send your Sims out to explore their new neighborhood 
and meet other Sims. They can look for a job at the sports stadium, get a massage at the day spa, or meet 
a friend for a bite at the local diner. With so much to do, new quick goals like Opportunities, and rewarding 
gameplay, The Sims 3 gives you the freedom to choose whether—or not!—to fulfill your Sims’ destinies and 
make their wishes come true.

Getting up to Speed
Whether you’re brand-new to The Sims experience or a seasoned player, we recommend that you play 
through the tutorial to learn what’s new in The Sims 3. This quick introduction will help you make the 
most of all the exciting new features!
You can reset the tutorial from the main menu if you want a refresher later or if you miss something the 
first time around. You can also access Lessons from the Options menu to learn more about all of the 
features in The Sims 3.

Getting Started
Getting started with The Sims 3 can be as easy as you like. You can jump right into a pre-made family, or 
you can choose to customize every aspect of your game by going through a few more steps.

 

To start a new game:
Choose a neighborhood from the pull-down menu, and then click the checkmark. Your selected 
neighborhood loads.
The first time you start the game, you can choose to either CREATE SIMS if you want to make 
your own custom Sims, or MOVE IN HOUSEHOLD if you want to move pre-made Sims from the 
library into your town and play them.

To see more info on creating custom Sims, see Create A Sim on p. 6.
After completing the tutorial (or opting out of it), you can also CHOOSE A HOUSEHOLD to play with pre-made 
Sims who already live in your selected town.
For pre-made households, click one of the blue house buttons to read a description of the household 
members and the house and see the difficulty level, the size of their lot, and how many Simoleons they have. 
Click the SELECT button to play at the description pop-up to play that household.
Note: Once you’ve completed the tutorial, you can also choose an empty lot and build a custom home for 
your Sims. For more on building, see Build Mode on p. 22.

Saving and Loading
A single saved game represents your entire town. To save, from the Options menu choose SAVE. Enter a 
name for your game and then click the checkmark. You can always start a new game from the main menu.
To load a saved game, go to the main menu and select the saved game that you want to play.

Options
At the Options menu you can change graphics, audio, gameplay, video capture, and music settings. Most of 
the options are self-explanatory, but a few are detailed below.
Autonomy 	 Move the slider to the left to decrease autonomy/free will or to the right to increase it. The 

more free will Sims have, the more they choose to act on their own if you haven’t assigned 
them an action. (Beware, your Sims won’t autonomously perform certain actions, such as 
getting a job. You’ll have to direct them to accomplish some things.)

Lifespan	 Determine how long (barring any unfortunate accidents) your Sim’s life will be by moving the 
slider to the desired number of days.



6 7

Create A Sim
Creating custom Sims has never been easier! You can adjust their appearance by choosing everything from 
the size of their nose to their body shape. Select the color of their eyes, add highlights to their hair, and even 
choose a lipstick shade. Then choose their wardrobe, determine their personality, and pick their favorite 
color, music, and food. Create any kind of Sim you can imagine!

Pre-Made Sims
At the Create A Sim screen you can choose a pre-made Sim by clicking the Pre-Made Sims button . 
To filter the view, click an age, gender, or body type. Click the Sim you want then click the checkmark. 
Your Sim is ready to go! If you want you can customize this Sim further by clicking the buttons at the 
left (see below).
If you want to create a totally customized Sim, start by clicking the Basics icon .

Basics
Enter your Sim’s name, choose their gender, set their age, adjust their skin tone, and define their 
body type (by setting how skinny or chubby they are and how much muscle tone they have).

Hair
Choose your Sim’s hairstyle (or hat) and hair color, determine their eyebrow shape and color, 
and select any facial hair (male Sims only). You can also set your Sim’s hairstyle per each outfit 
category if you want.

Choose a 
hairstyle

Select a 
hair color

Click this icon to 
randomize your Sim

Share this 
custom content

Click here to Create a 
Twin, Share Sim, or 
save your Sim

Choose a hat or 
other headwear

Customize 
hair color

Adjust this Sim’s 
eyebrows (including 

shape and color) 
and eyebrows

Click the lock to 
choose one hairstyle 
for all clothing 
categories (locked) 
or to choose different 
hairstyles for different 
categories (unlocked)

Looks
Choose your Sim’s head shape, adjust their ears, determine their eye color and shape, choose a 
mouth, nose, and any moles, freckles, or makeup.

Alter and refine 
the details of 

your Sim’s face Choose a general 
face shape

Click here to 
randomize this 
face’s features

Click one of the 
circles to tinker 
with details in 
that area of the 
face

Use the sliders 
to alter specific 

features

Clothing
Choose clothing for everyday and formal occasions, and select sleepwear, athletic wear, 
and swimwear. Within each category you can choose from tops, bottoms, outfits, shoes, 
and accessories.

Note: Your Sims must own a dresser to create new outfits in-game and they can have three different 
outfits for each clothing category.

Tip: You can also customize clothing by choosing colors and patterns. Whenever you see this icon , 
click it to adjust the style of the selected item. For information on customizing clothing (and other items), 
see Create A Style on p. 8.
Tip: Your Sim can change some aspects of their appearance (hair and makeup) at any mirror.

Personality
Set your Sim’s personality traits, favorites, and lifetime wish. For more information on traits, 
see p. 10 and for more info on lifetime wishes, see p. 12. You can also set their voice here and 
write a short biography.

Sometimes It’s All in the Details
Click the  to adjust the details of a specific part of your Sim. For instance, you can adjust the hair color, 
highlights, roots, and tips of your Sim’s hair. Or you can tweak your Sim’s nose: turn the tip up a bit, 
widen the bridge, or lengthen the nostrils. Whenever you see this icon , click it to see which details you 
can play with. On the Advanced tab, click one of the circles to select a different area to customize.
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Create A Style
You can use the new Create A Style to change patterns and colors on your Sims’ clothing, or you can create 
a coordinated room by adjusting the design of wallpapers, paint, furniture upholstery, and more.

Choose a pattern type 
(i.e., Fabrics, Carpeting 
& Rugs, Paint, etc.)

The pattern and colors 
of the selected item

Click one of these buttons 
to bring up the pre-set color 
palette, color wheel, or to 
enter RGB or Hex numbers

The selected pattern is 
made of two different colors

Move this slider to change 
the tint/tone (or lightness)

Click one of the two 
buttons to adjust it

Click one of 
these icons to 
delete, share, 

or save a style

Click here 
to view only 

custom 
content

Confirm or cancel 
your changes

Click one of the main 
swatches to see the different 

colors in it

Undo/redo each 
consecutive 
adjustment

Move the 
cursor on the 

color wheel 
to choose a 

color

Matching Shoes and More
You can also take a color or pattern and apply it to multiple items. Say you want your Sim’s shoes to exactly 
match her dress. Click her dress to select it, then click the pattern from her dress that you want to use on 
her shoes, and drag that pattern onto the shoes. If the shoes have more than one pattern, you can decide 
where you want to use that pattern. Click the checkmark to confirm your changes. 
Once you’ve saved a pattern, you can drag colors and patterns to furniture, décor objects, and accessories in 
Build and Buy modes.

Saving Custom Materials and Items

Once you’ve got a style of 
pattern that you’re happy with, 
you can save it to use again and 
again—just click the folder icon 
in the material category panel on 
the right

To save that particular 
clothing item (or object) 

in your custom style, 
click the folder icon in 

the window at the upper 
left of the screen
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Unique Sims
Customize your Sims more than ever to create a wide variety of Sims, each with their own distinct 
personality. Choose up to five traits from dozens of personality traits, choose favorite foods, colors, and 
music, and even adjust your Sim’s voice tone and pitch.

Traits
Your Sims can have up to five traits. Their traits influence what they want, how they feel, and how they 
behave. For instance, Sims who love the outdoors are happiest when they’re outside. Bookworm Sims can 
read more quickly and write better novels. Sims also tend to get along better with other Sims with whom 
they share at least one trait.
As Sims mature from babies to young adults, they gain more traits. If your Sim was very successful and 
happy in their last development stage, you may even get to pick the traits. However, if your Sim was only 
moderately happy, their new traits may be randomly chosen; if your Sim had a miserable experience at that 
life stage, they may be assigned negative traits.

A Good Personality
Erica has the following traits (in bold), which all impact her personality in different ways and help 
determine how she interacts with the world around her:
Because Erica is a loner, she doesn’t need to socialize as much as other Sims and prefers spending 
time alone. As a workaholic, she loves going to work (she even has fun there!) and she can also work 
from home on a computer. Erica is also a bit of a perfectionist, which means that though it takes her 
longer to do some things, she generally does them better than other Sims. An artistic Sim, Erica learns 
artistic skills such as painting, writing, and guitar playing faster than other Sims. She also loves to visit 
the art gallery. Because Erica is ambitious, she often gets raises and promotions faster than other 
Sims, but she also worries more if it’s been a while since her last promotion.

These are the traits from which you can choose. 

Mental Physical Social Lifestyle
Absent-Minded Athletic Charismatic Ambitious

Artistic Brave Commitment Issues Angler
Bookworm Clumsy Dislikes Children Childish 

Can’t Stand Art Couch Potato Easily Impressed Daredevil 
Computer Whiz Coward Flirty Evil 

Excitable Heavy Sleeper Friendly Family-Oriented 
Genius Hydrophobic Good Sense of Humor Frugal 

Green Thumb Light Sleeper Great Kisser Good
Handy Lucky Grumpy Hates the Outdoors 
Insane Neat Hopeless Romantic Hot-Headed 

Natural Cook Never Nude Inappropriate Kleptomaniac 
Neurotic Slob Loner Loves the Outdoors 
Virtuoso Unlucky Loser Over-Emotional 

Mean Spirited Perfectionist 
Mooch Technophobe 

No Sense of Humor Vegetarian 
Party Animal Workaholic
Schmoozer 

Snob 
Unflirty 

Favorites
You can also set a few favorites for your Sim. Choose grilled cheese sandwiches as their favorite food, 
orange as their favorite color, and pop as their favorite type of music. Your Sims will tend to choose their 
favorites when they can.

Voice
Choose a voice for your Sim and then adjust the pitch.

Skills
There are ten different skills that your Sims can develop throughout their life. The higher their skill levels, 
the better they are at performing certain tasks and activities. Additionally, as your Sims’ skills improve, more 
activities are available to them. Lastly, higher skill levels help your Sims advance in their careers. The skills 
your Sims need most depends on the career path they choose. For the most part, the skills for a certain 
career are fairly logical: to become a world-renowned chef, for instance, your Sim must excel at cooking. 
Other required skills may seem less obvious: on the law enforcement track Sims need logic skill (solving 
crimes may be elementary, but it takes some brain power!). For more information, see Careers on p. 12.
Your Sim can obtain a skill by reading books, practicing that skill, or taking a class at one of the buildings in 
town. To read a skill book, check out your Sim’s bookshelves, buy a book at the book store, or visit the library. 
Tip: If your Sim is in good mood, they build skills faster than when they’re in a bad mood.

Class Locations
Below is a list of each skill and where classes are offered to help your Sim learn it.

Skill Where to Take a Class
Athletic Stadium
Charisma City Hall
Cooking Bistro or Diner
Fishing Grocery Store
Gardening Science Lab
Guitar Theatre
Handiness Military Base
Logic Science Lab
Painting School
Writing Business/Journalism Office

Skill Journal
The skill journal gives an overview of each of your Sim’s skills, including the level to which that skill is 
developed, statistics pertaining to that skill (such as how many recipes a Sim has prepared), and the 
opportunities associated with it.

To bring up the skill journal, press ♦♦ J or click the skill journal button in your Sim’s skill panel.
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Wishes
Every adult Sim has a Lifetime Wish, something that they will strive for throughout their lifetime. These are 
bigger accomplishments that require more time and effort to achieve but are hugely fulfilling. When you 
create a young adult or older Sim, you choose their Lifetime Wish after you set their Traits. For younger 
Sims, you choose their Lifetime Wish during the game based on their activities and personality.
Your Sim also has smaller everyday wishes. These wishes include things like making a friend, getting a job 
in a certain career track, or falling in love. You have the option of promising up to four wishes to a Sim, or 
dismissing wishes as you see fit. Promising a wish means that you lock that as a focus for your Sim’s life. If 
your Sim fulfills that wish, they earn Lifetime Happiness Points. The wishes your Sim fulfills shape the path 
of their future wishes.
Click the arrows on either side of the wish panel to cycle through available wishes. To promise a wish, click it. It 
moves into one of the four promised wish spaces. You can also cancel a wish without penalty by right-clicking it.

Moodlets
Your Sim’s mood panel displays their overall mood and a variety of Moodlets. Moodlets are temporary 
conditions that directly affect your Sim’s mood and behavior. Moodlets are displayed as icons with different 
images on them, and have either red backgrounds (if they negatively affect your Sim’s mood), green 
backgrounds (for positive effects), or blue backgrounds (no effect on mood). Hover your mouse over a 
Moodlet icon to see what it is and how long it will impact your Sim. Your Sim’s personality will alter which 
Moodlets affect them and how powerful those effects are. 

Lifetime Happiness
Your Sim’s mood can directly improve their Lifetime Happiness. As long as your Sim has a really high mood, 
he gains Lifetime Happiness every second. The higher the mood, the more quickly your Sim earns Lifetime 
Happiness points. You can spend your Sim’s Lifetime Happiness points to purchase Lifetime Rewards.
To purchase Lifetime Rewards, click the Lifetime Happiness tab of the Sim Panels and then click the 
LIFETIME REWARDS button.

Careers
Careers are the best way for your Sims to earn Simoleons. Careers also get them out of the house and give 
them a chance to meet other Sims. There are eleven career paths that your Sims can follow, and many 
emphasize different skills.
Some careers also have different branches that your Sim can follow. For branching careers, when your Sim 
is promoted to a certain level, you can choose which branch you want your Sim to take. For example, the 
Law Enforcement career allows your Sim to become either a Special Agent or a Forensic Analyst.
Sims can find jobs by checking the newspaper, browsing on the computer, or simply by visiting the location 
in town where they’d like to work (you can use Map Tag filters to show job locations).

Job Performance
How well your Sim does in their chosen career depends on many factors. Your Sim’s mood always impacts 
their performance. Sims in better moods typically do a better job. Your Sim will be in a better mood for work 
if they’re well rested, well fed, and have had at least some fun in the last 24 hours.
Being late for work and leaving early also negatively affect your Sim’s job performance, so make sure they 
get to work on time. However, Sims always try to get to work on their own if you let them.
Some personality traits can also give Sims a boost in their chosen career. For example, a Sim who is 
athletic will have a much easier time pursuing the Professional Sports career, as well as some branches 
of law enforcement.
A variety of other factors can also affect your job performance (see p. 13).

The Career Panel
You can see how your Sim is doing at work by clicking the Career tab to bring up the Career panel. This 
panel shows your Sim’s current position, work schedule, salary, and performance. You can also see the 
different factors that affect job performance, such as mood, skills, or relationship with your Sim’s boss. 
Hover your mouse over one of the factors for more information about it. The better your Sim is doing in each 
of their factors, the faster their performance improves. If your Sim’s performance is maxed at the end of the 
work day, they will be promoted. Be careful though, because if your Sim’s performance falls too low, they 
may get demoted or even fired!
For example, a Yes-Man in the Political Career needs a good mood and a high Charisma Skill as well as a 
good relationship with his boss.
You can also send a Sim to work or school by clicking the button (it looks like a Sim sitting at a desk) in the 
career panel. This button only works around the time the Sim is scheduled to go to work or school.

Sim Action Options
Now you can do more than just choose which actions your Sim performs; you can determine how they perform 
them. When you assign your Sim actions that have different options, a small pull-down menu appears under 
the icon for that action in the action queue. For example, at work, your Sim can choose to MEET COWORKERS, 
WORK HARD, TAKE IT EASY, and more. Different actions provide different benefits and penalties, so choose 
wisely. It is almost always to your advantage to choose some action for your Sim though.
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A Living World
Your Sims live in a varied and dynamic town. Heading down to the local diner for a quick bite, studying at the 
library, or fishing at the local pond is just a click away.
In addition to this new freedom to move around the town, The Sims 3 also features an option called 
Story Progression. This feature helps keep your town alive and thriving. With Story Progression, your 
Sims’ neighbors lives progress normally. Neighbors may move away, new ones will move in, friends get 
promotions, neighbors have children, and eventually even die. Basically, life goes on! This feature helps to 
keep the neighborhood balanced. 
You can, however, choose to disable Story Progression (in the Options menu).
In Live Mode, you can click the button that looks like a skyline (or press M) to open Map View.

Click one of the filter 
buttons to show only the 
locations that apply to 
that filter

The green tag shows 
your current household, 
the orange map tag 
indicates the homes of 
Sims your Sims know, 
the blue map tag shows 
a workplace

Click one of the 
location buttons 

to have your Sim 
visit there, take a 
class, apply for a 

job, and more

Map Tags
Below are some of the tags that appear on the map and what they indicate. Mouse-over an icon to see its 
specific name.

 Your active Sim household is identified with this icon.

Venues
When your Sim enters one of these venues, you cannot see them or control them inside. But you can make 
choices about what they will do while they’re visiting. For example your Sim may enter the Grocery store to 
SHOP FOR GROCERIES, BECOME A PARTNER, SELL FRUITS AND VEGETABLES, ATTEND A FISHING CLASS, or 
GET A PART-TIME JOB.

Bistro Hospital

Bookstore Military Base

City Hall Police Department

Community Theatre School

Business/Journalism Offices Science Facility

Day Spa Sports Stadium

Diner Work

Grocery Store Criminal Warehouse

Community Lots
When your Sim visits a community lot, you can see and control them while they are inside.

Community Pool Library

Graveyard Park

Gym Art Gallery

Fishing Hole Beach

Generic community lot (Edit 
Town screen only)
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Homes and Neighbors
You can also click other Sims’ houses to go and visit them, even if your Sim doesn’t know them yet. Head 
across the street to meet the neighbors or visit a friend across town. Once your Sim is at the neighbors’, they 
can ask to come inside and make themselves at home (up to a point!).
Tip: When you mouse-over another house in the neighborhood, the cursor changes depending on whether 
anyone currently lives there  or no one lives there .

Community Locations
Your Sim can visit a variety of town locations including parks, the beach, shops, restaurants, and more. 
Some locations are venues for your Sims to wander around and explore.
For example, your Sim can visit the graveyard. At the graveyard they can get a part-time job, tour the 
mausoleum, explore the catacombs, mourn graveside, and even engrave epitaphs on tombstones.
Some buildings, such as work venues, are more basic. You can’t poke around, although you may be able to 
choose between different options for your Sim to perform while inside (see Sim Action Options on p.13 for 
more information on these options).

Live Mode
Live Mode is where all of the action takes place. Your Sim gets jobs, makes friends and enemies, falls in 
love, has a family, pursues their passions, and more, all in this mode.

Main User Interface Puck
Some of the functions are outlined here, but you can hover your mouse over any icon to see what it does.

Switch to 
Map View

Zero in on the 
selected Sim

Show walls down/
cutaway/up Rotate view

Click the arrows 
to cycle through 
available wishes

Promised 
wishes

Day and 
time

Hover over this icon 
to see this Sim’s 
lifetime wish

Click one of the icons to 
choose regular, fast, or 
ultra speed; Click the last 
icon to speed through 
the current action in this 
Sim’s queue

The selected Sim’s 
mood and contributing 
Moodlets

Click the arrow 
icon to bring up 
the Sim Panels 
(Simology, 
Relationships, 
Career, Skills, 
Opportunities, 
Inventory, 
Lifetime 
Happiness, 
and Needs)

Go up/down 
a floor

Start/stop 
capturing 

video

Take a 
screenshot

Getting a Hand on Things in Live Mode
Many items can now be moved around in Live Mode. You can return books to bookshelves, place trash in the 
bin, drag small items into your Sim’s inventory, and more.

 You’ll know that you can move an object when the cursor changes to include a small hand.
To move an object, click and hold the mouse and then drag to the new spot you’d like to place. An item that 
is currently in use cannot be moved. 

Inventory/Family Inventory
Each Sim has their own personal inventory. When a Sim picks up an object or brings it home from work, you 
will find it in their inventory. Click and drag to move objects into or out of their inventory.
Each household also has an inventory. Certain items go into the Family Inventory instead of an individual 
Sim’s inventory. You can access the Family Inventory in Buy mode by clicking the icon that looks like a 
cardboard box.

Cell Phone
Each Sim (except for toddlers and babies!) has their own personal cell phone in their inventory. When your 
Sim receives a call, just click your Sim and select ANSWER. To make calls, just go to your Sim’s inventory 
and click the phone icon.

A Day in the Life
This is a living room containing some ordinary objects. Take a look at some of the ways that your Sim can 
interact with them.

Practice chess

Choose a book 
for your Sim 

to read

Light 
the candles

View the art

Turn on the TV, 
watch a specific 

channel, or work out

Sit or nap 
on the sofa 
(or loveseat)

Turn on the 
stereo, work 

out, or dance
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Socialization
Most social interactions between Sims fall into one of these categories: Friendly, Romantic, Mean, Funny, 
or Special. Choose the type of interaction you want your active Sim to have with the other Sim, and then 
select a specific interaction from the sub-menu. Watch how the other Sim responds to your Sim’s social 
interaction—does he find it amusing or creepy? Be careful: if you choose the same social over and over 
again, the other Sim may get bored.

Special Interactions
Your Sim’s personality traits grant them special interactions. For example, Sims with the good trait can choose 
to BRIGHTEN SOMEONE’S DAY, while evil Sims can do a lot of normal interactions, but with an evil twist.

Relationship Panel
You can view the relationships your Sim has in the Relationship panel. If your Sim knows lots of Sims, you 
can even filter the view to see all relationships, or just relatives, friends, visitors, or co-workers.
Tip: Click the portraits in your Sim’s relationship panel to chat with those Sims or invite them over.

Opportunity Comes Knocking
Opportunities are chances for your Sim to advance either their career or skills by accomplishing different 
activities. Sims are given career opportunities while they’re at work, while skill opportunities may arrive at any 
time in the form of phone calls. Sims can also check the newspaper or computer for Special Opportunities. 
Once a Sim has accepted an opportunity, they are focused on it and will not be offered another opportunity 
of that type until the first has been accomplished, abandoned, or failed. You can abandon an opportunity by 
right-clicking it in the opportunity panel.
Every skill comes with a handful of Skill Challenges that could potentially take a lifetime to complete. 
These Challenges are difficult to achieve but the payoffs make it worth it. You can view these challenges 
in the Skill Journal.
Many opportunities have time windows for completion. Your Sim often isn’t finished with an opportunity until 
it has been turned in, usually at their workplace or to the Sim who provided the opportunity.

Collecting
Even if your Sim doesn’t love the outdoors, they can search for and collect specimens.

Butterflies and Beetles
Sims can venture outdoors to catch these buggy beauties. Once your Sim catches one, they can display it (in 
a terrarium), name it, sell it, or simply watch it. Each of these critters has a value, depending on its rarity.

Rocks, Gems, and Metals
Your Sims can also find rocks, gems, and metals if they explore. From space rocks to shiny gold to Plumbob 
emeralds, your Sim can have the gems they find cut to increase their value, or simply display them in their 
natural state.
To send your Sim’s gems off to have them cut, click one in their inventory and choose GET CUT and then the 
type of cut you’d like to have done. Your Sim mails their find off and gets back a beautiful cut stone.

Fishing
There are many bodies of water around town in which your Sim can fish. When your Sim is at a fishing 
locale, they can choose to INSPECT THE WATER or FISH. If your Sim has a least one fishing skill point and 
has fruits or vegetables in their inventory, you can also CHOOSE BAIT.
Your Sim can have a fish mounted to show it off at home. Click the fish in their inventory and choose SEND 
FISH TO BE MOUNTED. Your Sim can also choose to cook the fish they caught or put it in a fishbowl.

Gardening 
The more skill points your Sim has in gardening, the more options they have. Your Sim can take a class at 
the science lab, read gardening books, or watch the gardening channel to improve their skill. Working in the 
garden, of course, also improves their skill.

Seeds
When your Sim is out and about in town, they should keep their eyes open for seeds. Any seeds they find 
can be brought home and planted. Your Sims can also plant whole fruit and vegetables as a shortcut to 
finding seeds.

Cooking
Sims can start cooking as teenagers (or even earlier on the toy oven) and the more often they cook, the more 
cooking skill they acquire. Sims can also improve their cooking by watching cooking shows on TV, reading 
books on cooking, and taking classes. As your Sim gains more skill, they learn new recipes. Sims can also 
purchase new recipes at the grocery store.

Stocking Up
Your Sims also need to keep their kitchen stocked. Each recipe requires different ingredients, most of which 
can be attained at the grocery store. If you do not have the items for a dish on-hand, your Sim can prepare 
them, but they are charged more for the ingredients than if they stock up ahead of time. Meals made without 
the proper ingredients are lower in quality.

Recipe Book
You can see a Sim’s recipe book inside the skill journal entry for cooking. You can also view the types of 
foods they have prepared and how often, what their best meal was, and more.

Surprises in Your Sims’ New Home
When your Sims move in to a bare and unfurnished new home, sometimes they get more (or less!) than 
they bargained for… Perhaps their new abode comes with its own resident ghost, or worse yet maybe it’s 
already occupied by a host of rodent residents! The real estate agency may offer to take care of this not very 
welcome “surprise” for you, but if your Sims are resourceful, they can deal with matters themselves.
Who knows, if your Sims can take care of the problems, they might even find a surprise that they might want!

Changing the Active Household
To change the active household in your current town, from the Options menu choose EDIT TOWN. Then, 
click the CHANGE ACTIVE HOUSEHOLD button. This returns you to your initial choices: create Sims, play an 
existing household in town, or move in a household.
Changing to a different household leaves your previous household to change along with the rest of the town. 
Like other households in the neighborhood, they may get new skills or relationships, get fired or promoted, 
or change in other ways. You can always change back to that household, but it’s likely that things will have 
changed while you were gone!

You Played the Game. Now Play the Music.

EA Soundtracks and Ringtones 
�Available at www.ea.com/eatrax/

http://www.ea.com/eatrax
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Life Stages and Aging
Unless you opt to turn off aging (in the Options menu), all of your Sims will pass through several life stages 
(depending, of course, on how old they are when they start off). You now also have the power to decide 
when your Sims are ready for the next age category. Ready for your child to become a teen? Purchase a 
birthday cake and throw a party! A longer childhood increases your chances of being able to choose the 
traits for your Sim, but if you’re ready to move on, go right ahead.
Baby	 This time seems to fly past, making some Sims wistful for their little ones’ early cuddly 

years. Other Sims are thrilled when their tykes advance beyond simply eating and soiling 
their diapers.

Toddler	 These little ones are able to play their way into learning new skills, but still require a fair 
amount of care-taking from their parents.

Child	 The school years are a time for children to make friends, learn skills, and develop 
personalities. Keep their grades high to reap all of the benefits of these years.

Teen	 Young Sims start truly asserting their independence and may even fall in love for the first time. 
Teens can also get part-time jobs to get a jump on their careers—and earn a few Simoleons. 

Young Adult	 These Sims are ready to conquer the world. Some of them may be looking to climb their 
way up the career ladder, move in with a loved one, or just strike out on their own to see 
what the world has to offer.

Adult	 Sims at this life stage may be focused on starting families or aggressively advancing their 
careers or other life passions.

Elder	 The twilight years are a good time for Sims to pass on their wisdom to younger Sims and to 
take it easy, explore new hobbies, and indulge in their favorite pastimes. Elders also have 
the option to retire from their career and earn a pension.

Family Trees
Sims not only pass on their appearances (mom’s eye and hair color, the exact shape of dad’s nose) to their 
offspring, but they can also pass on traits when traits are randomly determined. You can view your Sim’s 
family tree at the Simology tab of the Sim Panels.

What to Expect When Your Sim 
Is Expecting
Pregnancy can take its toll on Sims, so make sure these ladies get plenty of rest and nutritious food. They may 
also experience some nausea and the need to visit the bathroom more frequently. But a happy pregnancy is 
not only good for keeping mom in better spirits, it also benefits the baby, so take care of your expecting Sims. 
Keeping mom’s mood high, reading pregnancy books, and asking a doctor for advice helps make the pregnancy 
a happy one.
Tip: A soothing massage can help ease those back pains, so if your Sim has a special someone who can 
provide some TLC, both mom and baby will be the better for it.
Sims looking to adopt can use the phone to call the adoption service, and can choose whether to adopt a boy or 
a girl. You can choose the age as well–from babies, toddlers, and children. The adoption service is free, too!

‘Til Death Do You Part
Sims are mortal and one thing is certain: they will eventually die (unless you turn aging off). If a Sim is 
fortunate enough to live to an advanced age, eventually they die a natural death. But some Sims meet with 
unfortunate accidents and can expire seemingly before their time. Beware of fires, drowning, starvation, and 
electrocution as all of these can end your Sim’s days prematurely.
But the death of a Sim doesn’t have to be the end of your town. Your surviving Sims will carry on, and will 
mourn the passing of their loved one. And even if the last Sim in your household dies, you can still go to Edit 
Town and choose a new household to play with.

Buy Mode
This is the place to purchase stuff to make your Sim’s life a little bit better. Whether you need to buy some 
no-frills essentials or are looking to splurge on some luxury goods, you can find it all here.
Note: For some items, such as books and food, your Sim needs to head to the shops downtown to get 
what they need.

Sorts
You can view items in the Buy Mode catalog by room or by function. You can also view items in the 
household inventory.

By Room
When you view items by room, you see an iconic representation of the types of items usually found in the 
room you select. Click any of the items to view that type of item. For instance, in the living room you can 
click the sofa to see sofas and loveseats, or click the painting to see paintings and posters.

By Function
This sort lets you take a look at items based on a need that you want to address. Maybe you need a 
comfortable place for your Sim to relax. So you click the Comfort filter. If you’re looking for a place to stow 
all of your Sim’s new books from their shopping spree, click the storage category.

Object Placement Rules and Options
The Sims 3 gives you more freedom to build, decorate, and furnish as you want. Use the new grid tool and 
the ability to position furniture at angles to get just the right look.

Grid On/Off
You can opt to show a grid when you’re in Build or Buy Mode that helps guide you about where to place 
objects. This allows you to center items better than ever, so you can position the TV across from the center 
of the sofa, a painting in between two windows, and more.

A New Slant on Furnishing
You can also place furniture and other objects at angles to give your room a more pleasing appearance. So if 
you want to place two chairs angled towards each other or position a plant in a corner—have at it.
Note: When you use free-form object placement and free-form object rotation Sims are more likely to 
walk into objects or to be unable to reach a specific place or object. Be careful to leave enough space for 
Sims to move around.

Furnished and Unfurnished Homes
When you choose a house for your Sims to buy from Town View, you have the option of purchasing it 
FURNISHED or UNFURNISHED. 
Unfurnished homes come with only the basics, such as plumbing (bathroom and kitchen), counters, 
cabinets, and a fridge. Furnished homes cost a bit more, but feature more amenities.

The Bare Necessities
The items below are necessities that every home should have. You don’t have to get the highest quality, but 
without at least a basic model for each of these, your Sim’s life will be more than miserable.

Fridge♦♦

Bed♦♦

Toilet♦♦

Tub or shower♦♦
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Build Mode
From seaside retreats to modest downtown starter homes, whatever you want to build happens here.

Sorts
Objects are sorted similarly to room sort in Buy mode—different categories of objects are laid out as you 
might find them on a lot.

Important Tools
Many of the tools in Build Mode are intuitive, but some may seem a bit tricky at first. These are explained below.

Walls
With this tool you can put up walls, even add a whole room at once, or paint and paper walls that are already 
standing.
To build walls, click the wall icon and then choose the Create Wall tool. Click the spot on the terrain or 
foundation where you want the wall to start and, while holding the mouse button down, drag out to where 
you want the wall to end. Release the mouse button here.
Note: You can create an entire room by using the Create Room tool (also under the wall sort) in the same 
way. Just click, hold, and drag out until you have the size room you want.
Tip: Made a room that’s too small, or put a wall in the wrong place? Just use the Hand tool to drag the wall 
to where you want it!

Terrain Paints
Add a gorgeous emerald green lawn or maybe one with a smattering of clover. Lay down tanbark, smooth a 
layer of sand, cover the ground with granite, and more.
To lay lush grass, choose the Terrain Paints sort, then the Terrain Paints brush tool. Next choose the type of 
paint you want to apply from the palette at the far right. You can also change your brush shape and size. Click 
and drag the brush tool over the terrain to apply the paint.
Note: Using more than four different terrain paints on one lot can adversely affect system performance. 

Trees, Shrubs, and Flowers
Whether you want a towering oak or a tiny pear tree, a lush rose bush, or some ubiquitous ice plant, these 
tools let you landscape to your heart’s content.
These landscaping items are all placed like Buy Mode objects. Simply click the object in the catalog that you 
want and then click a spot on the lot where you want to place it. 	

Sledgehammer
You’ve laid the foundation and added walls, but now that you look at it, you’ve constructed too close to 
street. Use this tool to quickly remove items.
To go on an obliterating spree, choose the sledgehammer tool and then use it to select items. To delete 
multiple objects, click and hold the mouse button while you drag over the stuff you want to zap.
Note: In Build Mode, to delete multiple objects, first click the type of object you want to delete and then 
drag over the rest of the items.

Custom Content
Record video footage of your gameplay, customize the in-game music, and more.
You can also upload your creations and share them with the entire Sims community. From Sims to sofas to a 
perfectly appointed pied à terre, you can upload your masterpieces and download other players’ too.

Video Capture
Tell your own stories using the video capture feature and the online Create A Movie tool at The Sims 3 Community. 
See Movie Making Mode on p. 2 for video capture and camera controls.
Note: All videos must be 1 GB or less.
Note: Capturing video at highest or uncompressed resolution results in very large file sizes and may affect 
performance. You can change your video capture settings at the Options menu.

Create A Movie
Use The Sims 3 Create A Movie tool to create your own movies. Use your own game footage or choose from 
a library of clips. Add a soundtrack, transitions, captions, and more!
To use your own game footage in the Movie tool:
After you’ve captured the footage, open the Game Launcher (from the Options menu). Click the UPLOADS 
button and, from the Uploads screen, select the footage that you want to use, and then click UPLOAD. 
A pop-up window appears where you can name your video and add a description. Once you’ve done that, 
click OK.
Note: You must be logged in as a game registered user to access the Movie tool.
From the Movies & More pull-down menu, choose CREATE A MOVIE. If you have uploaded your own 
videos and screen shots, you will see them in the Video Clips and Images tabs. Otherwise you can use the 
libraries provided.

To preview your 
entire movie, 

beginning with the 
currently selected 

clip, click here

Drag audio here

See if an effect 
has been applied 

to this clip

Drag clips that you 
want to include in 
your movie to the 
timeline

Add a 
caption to 
a clip

Transition (if any) 
applied to this clip

You can see all of 
the details of the 

selected clip in the 
timeline here and 

even preview it

Important Note: Mac users may not be able to view videos captured in The Sims 3  
on their computers without a video player that supports the VP6 codec. Once they have patched  
their game, Mac users will be able to upload movies to the Community site and make their own movies.
Please refer to the Readme file for more information. 
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Screen Capture
Take snapshots of all of the memorable events in your Sims’ lives.

To take a snapshot, press ♦♦ C. You can also click the camera icon on the UI puck.
When you take a screen shot it is saved to your documents folder under Electronic Arts\The Sims 3\
Screenshots. Screenshots (and videos) also automatically appear in the Uploads section of the launcher.

Custom Music
You can add your own music to the custom music folder to your documents folder under Electronic Arts\The 
Sims 3\Custom Music. Then your Sims can select that music as a radio station.

Important Note: The Launcher functionality for the Mac version of this game does not share the 
same functionality as the PC version. To update your Mac version of The Sims 3 and enable the full launcher 
functionality found in the PC game, go to Software Updates page of the launcher.

Save Your Content
Once you’ve customized your content, but while you still have Create A Style open, click the folder icon in the 
window at the top left of the screen. In some cases, a pop-up asks you to classify the type of content you want 
to save (i.e., Wallpaper or Paneling). Choose the appropriate content type. A thumbnail of your customized item 
should then appear in the window at the top left of the screen with a folder icon in the corner.
Once you have saved your item, you can then choose to share it.

Share Your Stuff
You can share Sims, Households, Lots, Patterns, Create A Style styles (designed objects), and Build and Buy styles.
To upload and share your stuff with The Sims 3 community, click the . A pop-up appears asking you to 
name your item and provide a description. Enter that information and then click the checkmark once the 
confirmation appears.
Once this is done, go to The Sims 3 Launcher and click the UPLOADS button. Check the boxes for the items 
that you want to share and click the UPLOAD button. After the item is successfully uploaded, it will be grayed 
out and you’ll see an icon next to it.
Note: You must be a game registered user to share content online.

View screenshots, custom 
content, and videos that 

you’ve uploaded

Share and upload objects, 
Sims, lots, etc.

Install and manage 
downloaded custom content

Uninstall or turn off installed 
custom content

Shop at 
The Sims 3 
Store

The Welcome screen 
includes links to your 

messages, the exchange, 
The Sims 3 Store, the 

latest news about  
The Sims 3, and more

Download software 
updates

Get More Stuff
You can get even more stuff for your Sims. From the launcher, visit The Exchange on the Community site to 
browse other players’ created content, or shop at The Sims 3 Store to purchase items using SimPoints.
Note: You must be a registered user to download from the store and the Exchange.

Download Other Players’ Stuff
From the Welcome screen of the launcher, click THE EXCHANGE, then click the Go to the Exchange link. 
Choose the category of content you want to download from the buttons at the left. Once you’ve selected a 
category, you can also filter your views. Once you locate the item that you want to download, click the ADD 
TO GAME button. 

Shop at The Sims 3 Store
From the Welcome screen of the launcher, click THE STORE, then click the Go to The Store link (or visit 
The Store by going to http://store.thesims3.com). You can browse items organized by various categories.
You must have SimPoints to make a purchase. You can purchase SimPoints directly through the Sims Store 
site with a credit card or PayPal.

Manage Content
Install downloaded content, and upload your custom content to the community. You can also delete items 
that are stored in your Downloads Manager (once you’ve already installed them within your game or 
uploaded them to the community).

http://store.thesims3.com
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Editing Your Town
Customize your town to suit your Sims. Perhaps the sports stadium is the most important place to your Sims 
and you want to give it a more central location. Or maybe there is community lot in a prime location and 
you’d like to make it residential. You can do all of this and more!
From the Options menu, choose EDIT TOWN. Your view of the town changes and you have new tools:

Select Tool
Use the select tool to choose lots in the town. Map tags denote the type of lot and what actions are available 
on the lot. 
When selecting a lot, you have some combination of the following options, depending on lot type:
Evict	 Move all Sims to the clipboard, with or without a copy of their home 
Split Up	 Send some of the members of the household to the clipboard. 
Merge With	 Combine the members of the household with another household.
Save to Library	 Place a copy of the household or lot in the library.
Share	 Save a copy to the launcher for upload. 
Change Lot Type	 Change lot types between community and residential.
Edit Details	 Edit the name and descriptions of the household or lot.
Note: If you evict all Sims from your current active household, you will no longer be able to play with 
them. You can continue editing the town, but you will need to select the CHANGE ACTIVE HOUSEHOLD button 
and select a new household before continuing to play. If you simply want to find your active household 
another house, you can use the phone, computer, or newspaper in Live Mode to move.

Move Lot Tool
With this tool you can pick up any lot in the town and move it to an empty lot elsewhere.
After you place a lot, you have the opportunity to rotate it to any suitable orientation. If there are people living 
on the lot, they must have enough funds to afford the empty lot on which they are being placed.

Build/Buy Tool
Use the Build/Buy tool to edit any unoccupied home in the game, or to build entirely new homes on empty lots.

Bulldozer Tool
Use the bulldozer tool to delete everything on a lot, converting it to an empty lot.
Note: You cannot build on or bulldoze an inhabited residential lot. If you want to alter an inhabited 
residential lot, you must first evict the current Sims.
Note: You are also free to get rid of work locations, although it will make certain careers unavailable. For 
example, if you get rid of the Science Lab, your Sims will be unable to join the Science career. 

The Clipboard
The clipboard, which appears on the left side of the screen, is temporary storage for Sims you’ve split or 
evicted from the world. Sims on the clipboard can be placed into their own home in the town using the 
PLACE option, or merged into an existing household using the MERGE WITH …’ option. Sims on the clipboard 
retain their relationships with other Sims in the town they were evicted from, However, the clipboard clears 
when you exit Edit Town mode, so be sure to place Sims back into the town before you start playing again.

The Library
The library is permanent storage for households and lots. Sims and lots in the library are available at all 
times to place into any town. Use the PLACE COPY option to copy a selected item into the town. You cannot 
edit items in the library, but can delete or share them at any time. Households created in Create A Sim, as 
well as lots/households that you share or download, are automatically placed in the library. Sims saved into 
the library lose all relationships with members of their town of origin.

Performance Tips

Macintosh Software Update
An outdated version of your MacOS X system software may lead to issues with game performance. To be 
sure that you have the latest version of MacOS X, choose ‘Software Update …’ from the Apple menu and 
follow the directions to update your system software.

Problems Running the Game
Make sure you meet the minimum system requirements for this game and that you have the latest ♦♦
drivers for your video card and sound card installed: 
For NVIDIA video cards, visit www.nvidia.com to locate and download them. 
For ATI video cards, visit www.ati.amd.com to locate and download them.
On a PC, if you are running the disc version of this game, try reinstalling DirectX from the disc. This is ♦♦
typically found in the DirectX folder on the root of the disc. If you have Internet access, you can visit 
www.microsoft.com to download the latest version of DirectX.

General Troubleshooting Tips
On a PC, if you have the disc version of this game and the AutoPlay screen does not automatically appear ♦♦
for installation/playing, right-click the disc drive icon found in My Computer and select AutoPlay.
If the game is running slowly, try reducing the quality of some of the video and sound settings from the ♦♦
game’s options menu. Reducing the screen resolution can often improve performance.
For optimum performance when playing, you may like to disable other background tasks (except the ♦♦
EADM application, if applicable) running in Windows.

Technical Support
If you have trouble with this game, EA Technical Support can help. 
The EA Help file provides solutions and answers to the most common difficulties and questions about how to 
properly use this product.

To access the EA Help file (with the game already installed):
Click the Technical Support link in the game’s directory located in the Start > Programs (or All 
Programs) menu or from within the Games Explorer on Windows Vista.

To access the EA Help file (without the game already installed):
1. 	 Insert the game disc into your DVD-ROM drive.
2. 	Double-click the My Computer icon on the Desktop. (For Windows XP, you may need to click the Start 

button and then click the My Computer icon).
3. 	Right-click the DVD-ROM drive that has the game disc and then select OPEN.
4. 	Open the Support > EA Help > Electronic_Arts_Technical_Support.htm file in North America or 

Support > European Help Files> Electronic_Arts_Technical_Support.htm in Europe.

To access the EA Help file on a Macintosh:
1.	 Insert the game disc into your DVD-ROM drive.
2.	 Click the Finder icon in the Dock.
3.	 Open a new Finder window by choosing ‘New Finder Window’ from the File menu.
4.	 Click the game disc icon in the Finder window.
5.	 Open the Support > Electronic Arts Technical Support.html file. 
If you are still experiencing difficulty after utilizing the information in the EA Help file you can contact EA 
Technical Support. 

http://www.nvidia.com
http://www.ati.amd.com
http://www.microsoft.com
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EA Technical Support on the Internet
If you have Internet access, be sure to check our EA Technical Support website at:
http://help.thesims.com
Here you will find a wealth of information on DirectX, game controllers, modems, and networks, as well as 
information on regular system maintenance and performance. Our website contains up-to-date information 
on the most common difficulties, game-specific help, and frequently asked questions (FAQs). This is the 
same information our support technicians use to troubleshoot your performance issues. We keep the support 
website updated on a daily basis, so please check here first for no-wait solutions. 

Technical Support Contact Info
If you need to talk to someone immediately, call our Technical Support team 
(Monday through Friday 8 AM – 5 PM PST):
Telephone: US 1 (650) 628-1001. 
Note: No hints or codes are available from Technical Support.
Website: http://support.ea.com
Mailing Address: �EA Technical Support 

9001 N I-35 Suite 110 
Austin, TX 78753

Limited 90-Day Warranty
Electronic Arts Limited Warranty
Electronic Arts warrants to the original purchaser of this product that the recording medium on which the software program(s) are recorded and the USB drive, if 
applicable, that are included with this product (collectively, the “Covered Components”) are free from defects in materials and workmanship for a period of 90 days 
from the date of purchase. If a Covered Component is found to be defective within 90 days from the date of purchase, Electronic Arts agrees to replace the Covered 
Component free of charge upon receipt of the Covered Component at its service center, postage paid, with proof of purchase. Electronic Arts reserves the right to 
replace the USB Drive component, if applicable, with any USB drive of similar value in its sole discretion. This warranty is limited to the Covered Components that were 
originally provided by Electronic Arts. This warranty shall not be applicable and shall be void if, in the judgment of Electronic Arts, the defect has arisen through abuse, 
mistreatment or neglect.
This limited warranty is in lieu of all other warranties, whether oral or written, express or implied, including any warranty of merchantability or fitness for a particular 
purpose, and no other representation of any nature shall be binding on or obligate Electronic Arts. If any such warranties are incapable of exclusion, then such warranties 
applicable to this product and Covered Components, including implied warranties of merchantability and fitness for a particular purpose, are limited to the 90-day period 
described above. In no event will Electronic Arts be liable for any special, incidental, or consequential damages resulting from possession, use or malfunction of this 
Electronic Arts product or the Covered Components, including damage to property, and to the extent permitted by law, damages for personal injury, even if Electronic 
Arts has been advised of the possibility of such damages. Some states do not allow limitation as to how long an implied warranty lasts and/or exclusions or limitation of 
incidental or consequential damages so the above limitations and/or exclusion of liability may not apply to you. In such jurisdictions, the Electronic Arts’ liability shall be 
limited to the fullest extent permitted by law. This warranty gives you specific rights. You may also have other rights that vary from state to state.

RETURNS WITHIN THE 90-DAY WARRANTY PERIOD
Please return the Covered Component along with (1) a copy of the original sales receipt showing the date of purchase, (2) a brief description of the difficulty you are 
experiencing, and (3) your name, address and phone number to the address below and Electronic Arts will mail a replacement to you. If the Covered Component was 
damaged through misuse or accident, this 90-day warranty is rendered void and you will need to follow the instructions for returns after the 90-day warranty period. 
We strongly recommend that you send your Covered Component using a traceable delivery method. Electronic Arts is not responsible for Covered Components not 
in its possession.

EA Warranty Information
If the defect in the Covered Component resulted from abuse, mistreatment or neglect, or if the Covered Component is found to be defective after 90 days from the date of 
purchase, choose one of the following options to receive our replacement instructions:
Online: http://warrantyinfo.ea.com
Automated Warranty Information: You can contact our automated phone system 24 hours a day for any and all warranty questions:
US 1 (650) 628-1001

EA Warranty Mailing Address
Electronic Arts Customer Warranty
9001 N I-35 Suite 110
Austin, TX 78753

Notice
Electronic Arts reserves the right to make improvements in the product described in this manual at anytime and without notice. This manual and the product described in 
this manual are copyrighted. All rights reserved.

Technical Support Contact Info
E-mail and Website: For instant access to all of our technical support knowledge, please visit http://techsupport.ea.com.
Telephone Support: Technical Support is also available from 8am to 5pm PST by calling us at (650) 628-1001. No hints or codes are available from (650) 628-1001.
Mailing Address: �Electronic Arts Technical Support, 9001 N I-35 Suite 110, Austin, TX 78753

© 2009 Electronic Arts Inc. EA, the EA logo, The Sims, The Sims 3 logo, and The Sims plumbob design are trademarks or registered trademarks of Electronic Arts Inc. in 
the U.S. and/or other countries. All Rights Reserved. RenderWare is a trademark or registered trademark of Criterion Software Ltd. Portions of this software are Copyright 
1998-2009 Criterion Software Ltd. and its Licensors. All other trademarks are the property of their respective owners.

Uses Granny Animation. Copyright © 1999-2009 by RAD Game Tools, Inc.
Macintosh Conversion by TransGaming Inc.
This game uses Cider(tm) Technology from TransGaming Inc. Cider(tm) is Copyright © 2000-2009 TransGaming Inc.
Cider C/C++ runtime components (msvcrt.dll, msvcr71.dll, msvcp71.dll, msvcr80.dll, and msvcp80) include portions of Visual C++ 6.0 runtime components and portions 
of Dinkum Compleat C/C++ Libraries. Visual C++ 6.0 runtime components are Copyright © 1999 Microsoft Corp. Dinkumware components are Copyright © 1989-2006 
by P.J. Plauger and Dinkumware Ltd.
Cider MFC & ATL components (MFC42.dll, MFC71.dll) include the Visual C++ 6.0 MFC & ATL components. Visual C++ 6.0 MFC & ATL components are Copyright  
© 1992-1999 Microsoft Corp.
Cider includes libpng, Copyright © 1995-2004 the libpng project authors (see http://www.libpng.org/pub/png/src/libpng-LICENSE.txt for a complete list)
This software is based in part on the work of the Independent JPEG Group. Cider includes libjpeg, copyright © 1991-1998, Thomas G. Lane. 
Cider uses NVIDIA’s Cg Toolkit, Copyright © 2002-2008, NVIDIA Corporation.
Cider includes dmalloc, Copyright © 2001-2006 Wolfram Gloger
Cider includes CSRI malloc, Copyright (c) 1988, 1989, 1993 University of Toronto
Cider includes SDL, Copyright (c) 2001-2007 the SDL project authors (see http://libsdl.org/credits.php for a complete list). SDL is available under the terms of the GNU 
Lesser General Public License (LGPL) found below.
Cider includes The Better String Library (bstring) Copyright (c) 2002-2006 Paul Hsieh
Portions of this software are Copyright (c) 2006, Industrial Light & Magic, a division of Lucasfilm Entertainment Company Ltd. Portions contributed and copyright held by 
others as indicated. All rights reserved.
iniParser Portions Copyright (c) 2000 by Nicolas Devillard.
Portions of this software are copyright © 1996-2000 The FreeType Project (www.freetype.org). All rights reserved.
Portions of this software are copyright © 2006 Simon Brown and contributors of the Squish project (http://sjbrown.co.uk/?code=squish). All rights reserved.
The Cider libquartz.dylib component includes portions of ffmpeg, Copyright © 2000-2006 Fabrice Bellard, et al.
Cider and related components are distributed under the terms of the Cider Technology License and other licences, including the GNU LGPL. License details are available 
in the End User License agreement.
Portions of Cider are Copyright © 2002-2006 the ReWind project authors (see http://cvs.transgaming.org/cgi-bin/viewcvs.cgi/rewind/AUTHORS?root=rewind for a 
complete list).
Portions of Cider are Copyright © 1993-2008 the Wine project authors (see http://source.winehq.org/source/AUTHORS for a complete list).
Source code to the LGPL components is available through: http://transgaming.org/cvs/
Other Cider components available via CVS are licensed separately under terms described in the LICENSE files that accompany them.
This game incorporates dynamic advertisement serving technology offered by IGA Worldwide Inc. (“IGA Technology”), which enables advertising to be temporarily 
uploaded into the game on your PC or console, and replaced while you are online. IGA Technology only logs information that is needed to measure presentation of 
advertising, and to serve advertising to the appropriate geographic region and to the right location within the game. Logged data may include Internet Protocol Address 
(“IP Address”), in game location, length of time an advertisement was visible, size of the advertisements, and angle of view. The IP Address is deleted when the online 
game session ends. Your game may be assigned an id number, which is stored on your PC or console, and used by IGA Technology to calculate the number of unique 
and repeat views of dynamic in game advertising. The id number is not associated with any personal data. No logged information is used to personally identify you. This 
ad serving technology is integrated into the game; if you do not want to use this technology, do not play the game while connected to the Internet. For more information 
see our privacy policy at privacy.ea.com.
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